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About the User Guide
The Rio 800 User Guide includes the following information:
Introduction

Using your Rio

Using Rio menu options and settings

Using the Rio software

Understanding digital audio terms

Common questions about the Rio 800

Warranty

Regulatory information

Customer care

Index

To learn more:
� Refer to the Getting Started Guide for the basics on how to set up and start using 

your Rio.
� Click on the Rio Audio Manager, AudibleManager, or SoundJam software Help menus for 

detailed step-by-step instructions on how to use the software to convert CD tracks into 
compressed digital audio formats, get audio from the Internet, or transfer tracks to and 
from the Rio.

� Visit the Rio Web site

Navigating and printing the Rio 800 User Guide
The User Guide is in Adobe Acrobat (.PDF) file format. 

Important: We strongly recommend that you use Adobe Acrobat Reader version 4.0�
available on the Rio software CD-ROM�to view and print the Rio User Guide.

Click on links (blue underlined text) to jump to another location in the document or to a 
location on the World Wide Web.

Click on the Index icon at the top of any page (by the page number) to go to the index�or 
you can click on the Index bookmark. Click on page numbers in the index to jump to a topic.

Using Acrobat toolbar icons
Click on the Show/Hide Navigation Pane icon in the Acrobat toolbar to show a list of 
bookmarks. Bookmarks are links to the contents of the User Guide. Click on any 
bookmark in the list to jump to the page in the User Guide that contains the topic.
Click on the Print icon in the Acrobat toolbar to print the User Guide. The size of the 
User Guide is optimised for printing.

http://www.riohome.com
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Introduction
Introduction
The Rio 800 provides ultimate access to your favourite music or spoken audio while you 
exercise, commute, or relax. Create and mix your favourite musical selections on your PC or 
Mac for playback on the Rio. It�s like virtual reality for your ears. Your Rio is similar in function 
to a portable cassette or CD player. However, it has no moving parts, so the Rio does not skip 
or jitter during playback. The rechargeable battery, and voice recording option make the Rio 
800 the ultimate digital audio player. 
The Rio comes with 64 MB of built-in memory. You can further expand the Rio memory 
storage with accessory backpacks. There are many cool accessories you can purchase 
separately to customise your Rio. Visit the Rio Web site for information about accessories or 
to place an order online.
The Rio interfaces with your computer through the USB port. Use the software included on 
the CD-ROM to:
� Create your own custom song mixes to take with you on your Rio.
� Create compressed digital audio tracks from your audio CDs using your computer�s 

CD-ROM drive.
� Create a custom CD-ROM.
� Convert and organise the contents of your CD collection into compressed digital 

audio tracks.
� Download digital audio files from the Internet to the Rio via your computer.
There are many sources of digital audio content on the Internet, including: 
Rioport.com 
WindowsMedia.com 
Audible.com�for spoken audio

http://www.riohome.com
http://www.rioport.com
http://windowsmedia.com
http://audible.com
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Using your Rio
This section explains what you need to know about:
Using Rio buttons and controls
Using the rechargeable backpack

Using Rio buttons and controls
� Select: The Centre Rio joypad button. In menu mode, press Select to choose a menu or 

dialogue option. 
� >/||: Play/Pause; the top button on the joypad. In play mode, press >/|| once to play a 

track; press it again to pause. When paused, the play/pause icon appears as two blinking 
vertical bars on the LCD. If your Rio is left in Pause mode for an extended period of time, 
it goes into sleep mode to conserve battery life. Press >/|| to wake your Rio from sleep 
mode. In menu mode, press >/|| to navigate up through menu options.

� !: Stop; the bottom button on the joypad. In play mode, press ! to stop playing the 
current track. Press and hold ! for about two seconds to put your Rio into sleep mode to 
conserve battery life. In menu mode, press ! to navigate down through menu options.

� >>: Forward; the right button on the joypad. In play mode, press and release >> to skip to 
the next track on your Rio. Press and hold >> to fast-forward through the track currently 
playing. In menu mode, press >> to navigate through menu options.

� <<: Reverse; the left button on the joypad. In play mode, press and release << to skip to 
the beginning of the track currently playing on your Rio. Press and hold << to fast-rewind 
through the current track. In menu mode, press << to navigate through menu options.

Menu

Play/Pause

LCD

Record

Microphone

Select

Stop

Forward

Reverse

On/Hold/OffMultifunction port

Volume
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� Menu: Press the Menu button to display the Rio menu options. Press >/||, >>, <<, and ! 
to navigate through menu options. Press Select to choose a menu option. Generally, 
pressing Menu while in menu mode before saving any changes returns the Rio to play 
mode without saving.

� Rec: The Record button on the Rio. Press Rec to display the Recorder options menu, 
where you can choose to record your voice or play a recording. See the section on 
Recording and Playing Voice for instructions and more information.

� Liquid Crystal Display (LCD): In play mode, the LCD provides the following 
information�clockwise from right:

� Play/Pause icon: Displays either a Play icon (triangle) or a Pause icon (two vertical 
bars), to show the current action of the Rio.

� Current song position: Displays the play location in the current track in 
minutes:seconds (mm:ss) form. For Audible content, the display includes hours 
(hh:mm or hh:mm:ss).

� Volume level: Displays the volume setting in both digital and graphic form. The bar-
graph disappears as volume is reduced and re-appears as volume is increased. 
Volume level ranges from 0-20.

� Track display: Displays the number of the currently selected track and the total 
number of tracks on your Rio. Tracks are numbered from 1-99. If a playlist is active, 
the track count shows the number of tracks in it. If a large storage device is used, the 
total content is organised by playlists of up to 99 tracks.

� Album name/artist name: Album name is displayed in this field for a few seconds, 
followed by artist name. If the name is longer than the width of the display, the 
name scrolls. 

� Track information: Track information includes the codec type (MP3, WMA, and so on), 
the bit rate (XXX kbps), and the file size (XX:XX MB).

� Song name: Displays the title of the currently selected track. Song name scrolls if the 
name is longer than the width of the display.

� Hold icon (key): Appears if the Rio is set to Hold mode. Hold locks all settings except 
the Power switch on the Rio. 
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Using the rechargeable backpack
The first time you charge the battery backpack, it is important to calibrate it and give it a full 
charge overnight or until the calibration timer expires. Calibrating the battery ensures 
accurate battery level display. You do not need to charge the battery before you calibrate it.

Note: You do not have to calibrate the battery each time you charge it�only the first time. 

See the section on Battery Calibration for instructions and more information.
For subsequent chargings you can charge the backpack until the charge indicator goes off for 
a quick charge�after about 1.5 hours�or leave the AC adapter attached for about 2.5 hours 
for a full charge. Full charge allows you to play music for about 10 hours.
You can leave the backpack plugged into the AC adapter after charging is complete to 
maintain the charge. In addition, you can use your Rio to play music while the backpack 
is charging. 

Warning: Do not remove the rechargeable battery from the backpack. Batteries may 
explode or leak if disposed of in fire, inserted backwards or disassembled. 
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Using menu options and settings
When the Menu button is pressed, the LCD displays Rio menu options: 

� Audio: Preset and custom equaliser settings.
� Player: Random and repeat play options, delete track, and playlist functions.
� Prefs: Player settings including power saving (time to sleep), LCD display backlight and 

contrast, time and date, and battery level and calibration.
� About: Miscellaneous player status information including firmware version, internal and 

external memory used, battery level, calendar, and codec information.
� Record: Voice recording and playback options.

Using Audio functions
Audio functions include built-in and custom equaliser (EQ) settings. Custom EQ lets you set 
the Treble and Bass values from 1 (low) to 9 (high).

Selecting built-in EQ settings
1 Press Menu.
2 Press the << or >> joypad buttons to navigate to Audio.
3 Press Select.
4 The EQ settings are displayed.

5 Press the >/||, !, << or >> joypad buttons to highlight the desired setting.
� To save the setting, press Select.
� To return to play mode without saving any changes, press Menu.
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Setting the Custom EQ
1 Press Menu.
2 Press the << or >> joypad buttons to navigate to Audio.
3 Press Select.
4 The EQ settings are displayed.
5 Press the >/||, !, << or >> joypad buttons to navigate to Custom.
6 Press Select.

7 Press the >/|| or ! joypad buttons to toggle between Bass and Treble.
8 Use the << or >> joypad buttons to increase or decrease the Bass or Treble value from 

1 (low) to 9 (high).
� To save the settings, press Select.
� To return to play mode without saving any changes, press Menu.
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Using Player functions
Player functions include:
� Play options: Repeat or randomise tracks.
� Delete tracks: Remove content from the Rio.
� Playlist: Select playlists, create new playlists, manage playlists downloaded from your 

computer or remove playlists from the Rio.

Setting Repeat and Random play options
1 Press Menu.
2 Press the << or >> joypad buttons to navigate to Player.
3 Press Select. 
4 Navigate to Play Options.
5 Press Select.
6 Press the >/|| or ! joypad buttons to toggle between Repeat or Random. 
7 Press the << or >> joypad buttons to change the Repeat or Random setting. 

Repeat settings include:
� All: All tracks repeat.
� Track: Current track repeats.
� Off: Turns off repeat function. 
Random settings include:
� On: All tracks play in random order.
� Off: Turns off random function.

8 Press Select to save the settings. To return to play mode without saving any changes, 
press Menu.
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Deleting tracks from the Rio
1 Press Menu.
2 Press the << or >> joypad buttons to navigate to Player.
3 Press Select. 
4 Press the joypad buttons to navigate to Delete Tracks.
5 Press Select. A list of all tracks is displayed.

6 Press the >/|| or ! joypad buttons to navigate to the track you want to delete.
7 Press Select.

� Highlight Yes on the Delete dialogue, then press Select to delete the track.
� Highlight No on the Delete dialogue, then press Select to return to the track list 

without deleting the track.
� To return to play mode without saving any changes, press Menu.
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Working with Playlists
Playlist options include:
� Choose: Select a playlist from playlists stored on the Rio. 
� New: Build a new playlist.
� Edit: Modify an existing playlist.
� Remove: Remove a playlist from the Rio.
1 Press Menu.
2 Press the << or >> joypad buttons to navigate to Player.
3 Press Select. 
4 Navigate to Playlist.
5 Press Select.
6 Press the <<, >>, >/|| or ! joypad buttons to highlight Choose, New, Edit or Remove 

playlist options. 
7 Press Select.

Choosing a playlist
1 Select the Choose playlist option. Any existing playlists are displayed.
2 Press the >/|| or ! joypad buttons to highlight the desired playlist.
3 Press Select.

Building a playlist
1 Select the New playlist option. New playlists are numbered in sequential order starting 

at �01�.
2 The playlist editor displays all tracks on the Rio.

3 Press the >/|| or ! joypad buttons to highlight a track. 
� Press Select to assign a playlist order number to the track. The number indicates the 

order in which the track is played in the playlist. 
� Press the << or >> joypad buttons to change the track order number. 

4 When you have finished, highlight -done editing- at the bottom of the playlist editor, then 
press Select to save the new playlist and exit to the playlist options menu.
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Modifying a playlist
1 Select the Edit playlist option. 
2 Press the >/|| or ! joypad buttons to navigate to the playlist.
3 Press Select.
4 The playlist editor displays tracks and their playlist order numbers in the left column.

� To add or remove tracks from the playlist, highlight a track and press Select to tag or 
untag the track with a number in the left column. This number indicates the order in 
which the track is played in the playlist.

� To change the track order number in the playlist, highlight a track and press the << or 
>> joypad buttons.

5 When you have finished, highlight -done editing- at the bottom of the playlist editor, then 
press Select to save the new playlist and exit to the playlist options menu.

Removing a playlist
1 Select the Remove playlist option. 
2 Press the >/|| or ! joypad buttons to highlight the playlist you want to delete.
3 Press Select.

� Highlight Yes on the Delete dialogue again, then press Select to delete the playlist.
� Highlight No on the Delete dialogue, then press Select to exit without saving 

any changes.
� To return to play mode without saving any changes, press Menu.
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Setting Preferences
Preferences include these Rio settings:
� Power saving (time to sleep).
� Display backlight and contrast.
� Time and date.
� Battery level display and calibration.

Adjusting the power saving setting
You can adjust the time to sleep (suspend) setting from one to nine minutes. To turn off the 
power saving feature, set the time to sleep setting to 0 (zero).
1 Press Menu.
2 Press the << or >> joypad buttons to navigate to Prefs.
3 Press Select. 
4 Press the joypad buttons to navigate to Power Saving.
5 Press Select. 

6 Press the << or >> joypad buttons to adjust the power saving setting.
� To save the setting, press Select.
� To return to play mode without saving any changes, press Menu.

Adjusting LCD display backlight and contrast
1 Press Menu.
2 Press the << or >> joypad buttons to navigate to Prefs.
3 Press Select. 
4 Press the joypad buttons to navigate to Display.
5 Press Select.

6 Press the >/|| or ! joypad buttons to toggle between Backlight and Contrast.
7 Press the << or >> joypad buttons to adjust the Backlight or Contrast setting. 

Backlight settings include:
� Timed 1, 2, 5, or 10 seconds.
� Always on or Always off.
Contrast settings range from 1 (minimum) to 9 (maximum).

8 Press Select to save the settings.
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Setting time and date
1 Press Menu.
2 Press the << or >> joypad buttons to navigate to Prefs.
3 Press Select. 
4 Press the joypad buttons to navigate to Time/Date.
5 Press Select.

6 Press the << or >> joypad buttons to highlight each of the time and date fields.
7 Press the >/|| or ! joypad buttons when any of the time or date fields is highlighted to 

change the value. The date field will not roll to a value that is not valid for the selected 
month and year.

8 Press Select to save the time/date settings. To return to play mode without saving any 
changes, press Menu.
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Displaying battery information
1 Press Menu.
2 Press the << or >> joypad buttons to navigate to Prefs.
3 Press Select.
4 Press the joypad buttons to navigate to Battery. 
5 Press Select.
6 Press the joypad buttons to navigate to Power level.
7 Press Select to display battery information:

� Battery type: Rechargeable or Normal.
� Battery charge level: The battery�s charge state (percentage).
� Run time estimation: The battery�s remaining play time.
� Battery level graphic: A bar graph inside a battery icon displays the approximate 

remaining charge.
8 Press Menu to return to play mode.

Calibrating the battery
Calibrating the battery ensures accurate battery level display. It is important to calibrate the 
battery backpack and give it a full charge overnight or until the calibration timer expires the 
first time you charge it. You do not need to charge the battery before you calibrate it. 

Note: You do not have to calibrate the battery each time you charge it�only the first time. 

1 Connect the AC adapter into your Rio�s backpack port at the bottom of the backpack.
2 Plug the AC adapter power lead into a socket. The charge indicator on the backpack 

comes on when charging begins. 
3 Slide the Rio power switch to On.
4 Press Menu.
5 Press the << or >> joypad buttons to navigate to Prefs.
6 Press Select.
7 Press the joypad buttons to navigate to Battery. 
8 Press Select.
9 Press the joypad buttons to navigate to Calibrate.
10 Press Select.
11 Wait overnight or until the timer expires to give the backpack a full charge. 
12 When charging is complete, unplug the AC adapter from the Rio�s backpack port.
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Displaying About information
1 Press Menu.
2 Press the << or >> joypad buttons to navigate to About.
3 Press Select. The following information is displayed:

� Player personalisation message defined through the software or Rio model number.
� Firmware version the Rio is using. 
� Total internal memory amount installed and a bar graph display of the amount used.
� Total external memory installed and a bar graph display of the amount used.

4 Press the ! joypad button to display battery information including:
� Battery type: Rechargeable or Normal.
� Battery charge level: The battery�s charge state (percentage).
� Run time estimation: The battery�s remaining play time.
� Battery level graphic: A bar graph inside a battery icon displays the approximate 

remaining charge.
5 Press the ! joypad button to display clock and calendar information.

6 Press the ! joypad button to display codec information.

7 Press Menu to return to play mode.
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Recording and playing voice
Recording your voice

Note: The recorder automatically turns off the backlight when in use to prevent 
background noise from the backlight from interfering with your recording.

1 To record your voice you can either:
� Press the Rec button on the Rio, or
� Press Menu, press the joypad buttons to navigate to Record, then press Select.

2 Highlight New Recording and press Select to start recording.
3 Press ! to stop recording.
The Recording display includes:

� Status Message: Displays �Preparing to Record�, �Recording��, �Recording Done�, 
and so on.

� Recording time elapsed: Displays duration of the present recording in 
hours:minutes:seconds (hh:mm:ss). 

� Memory used graph: Displays how much memory is used and how much is free 
for recording.

� Percentage of memory remaining: Displays how much free flash memory is left. 
� Record level meter: Displays relative volume sensed at the microphone.

Playing a recording
1 To play a recording you can either:

� Press the Rec button on the Rio, or
� Press Menu, press the joypad buttons to navigate to Record, then press Select. 

2 Highlight Play Recordings and press Select. A list of recordings on the Rio is displayed:

3 Press >/|| or ! to highlight a recording. 
4 Press Select to play the highlighted recording. 
5 Press Menu to exit to play mode.
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Using the Rio software
Rio Audio Manager (PC)
The Rio Audio Manager creates, stores, and organises your digital audio tracks. The 
software incorporates tools for you to manage digital audio content from your PC. Click on 
the buttons along the top of the Rio Audio Manager window to use the various digital audio 
management tools.
Use Rio Audio Manager to:
� Create and organise audio content on your computer.
� Organise audio content on your Rio.
� Create a custom CD-ROM. Rio Audio Manager allows you to write 25 tracks to CD free 

of charge. Note: To unlock unlimited CD writing, you must upgrade the software for 
a small fee.

� Create compressed digital audio tracks from your music CDs. Use Rio Audio Manager to 
convert your entire CD collection to compressed digital format. Note: The software allows 
50 free MP3 encodes prior to a free upgrade that unlocks Rio Audio Manager for 
unlimited MP3 encoding. However, WMA is the default setting for encoding CDs, and 
WMA encoding is unlimited and free.

� Search for and download digital audio from the Internet. 

Tip: For in-depth instructions on using the Rio Audio Manager software, click on the 
software Help menu, then click on Help Topics.
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Rio Audio Manager buttons
Make a playlist
Click on this button to organise audio tracks into playlists on your computer. Listen to playlists 
directly from your PC. 
1 Click on the make a playlist button.
2 Click on the Select Tracks from Database or Select Playlists from Database buttons.
3 Select tracks you wish to listen to by clicking on the check box to the left of the song title. 

Scroll down as necessary to find a track.
4 Click on the OK button. The main screen displays the selected tracks.

Copy to devices
Click on this button to organise the content on your Rio. Download tracks to your Rio for 
playback on the move. 
1 Plug the USB cable into the multifunction port on top of your Rio 800; plug the other end 

of the cable into the USB port on your PC.
2 Slide the power switch on top of your Rio to On.
3 Click on the copy to devices button.
4 Click on the Select Tracks from Database or Select Playlists from Database buttons.
5 Select the tracks you want to download from your playlist by clicking on the check box to 

the left of the song title.
6 Click on the OK button.
7 Click on the Copy to Portable button.
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Write audio CDs
Create custom CDs from your favourite tracks and playlists stored in the database. See the 
Rio Audio Manager online help topics, and your computer�s software and hardware 
documentation for detailed instructions on writing audio CDs.

Read a CD
Take your favourite songs from a CD and convert them to compressed digital audio tracks for 
playback on your Rio or PC. Click on the Get Track Titles button to connect to the Gracenote 
Web site�formerly CD Database (CDDB)�for title, artist and track information.
1 Insert an audio CD in your computer�s CD-ROM drive. 
2 The software prompts you to go online to the Gracenote Web site. 

� If you have an Internet connection, click on Yes to immediately connect to Gracenote. 
� If you do not have an Internet connection, click on No.

3 Select the tracks you want to convert by clicking on the check box to the left of the 
song title.

4 Click on the Start Reading button.

Rioport.com
The built-in Internet browser connects you to sites like the RioPort Web site at 
www.rioport.com. Search for your favourite audio tracks on the Web and download them 
directly to your computer. 
To download a song from the RioPort Web site:
1 Click on the title.
2 Click on the Download button. 

Use the Help system to learn more
The Rio Audio Manager software includes a complete online Help manual. To learn more 
about using Rio Audio Manager:
1 Click on the Help Menu at the top of the Rio Audio Manager screen.
2 Click on Help Topics.
3 Click on the topic you are interested in for detailed step-by-step instructions on using 

Rio Audio Manager.

AudibleManager (PC)
The AudibleManager software supports audio books, lectures, public radio programmes, 
newspapers, and other spoken word audio programmes. 
Use AudibleManager to:
� Create an Audible.com account, where you may choose from thousands of spoken word 

audio programmes.
� Download audio programmes from the Internet to your PC.
� Transfer audio programmes to your Rio. 
For more information, visit the AudibleManager Web site.

http://audible.com
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SoundJam MP (Mac)
SoundJam MP player and encoder converts music to compressed digital quality MP3s from 
CD, MP2, AIFF, QuickTime�, SMD, Sound Designer, and WAV formats. 

Master Playlist
Use the Master Playlist editor to:
� Search the audio collection stored on your Mac.
� Build and manage custom playlists.

Main Window
Use the SoundJam MP Main Window to:
� Listen to audio on your Mac.
� Play music files from your playlist or CD-ROM.
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Converter
Use the Converter window to:
� Encode audio CDs.
� Save tracks in MP3 format to be transferred to and played on your Rio.

Connector
The Connector window is displayed when you 
plug your Rio into your Mac using the USB cable.  
Use the Connector window to:
� Manage the content on your Rio. 
� Export audio to your Rio. Choose the track by 

selecting �Add...� or drag the desired track to 
the view window.

Use the Help system to learn more
The SoundJam software includes online Help. 
To learn more about using the SoundJam 
MP software:
1 Click on the Help Menu.
2 Select SoundJam MP Help. 

� Click on the topic you are interested in for 
detailed step-by-step instructions.

� Click on How To Use This Help System to understand the basics of using 
SoundJam Help.

For more information about SoundJam, visit the SoundJam Web site.

http://www.soundjam.com
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Digital audio terms
AAC
Advanced Audio Coding (AAC) is one of the audio compression formats defined by the 
MPEG-2 specification. AAC used to be called NBC (Non-Backward-Compatible), because it 
is not compatible with the MPEG-1 audio formats. AAC may eventually replace MP3 since it 
offers better sound quality and greater file compression. 

ADPCM
Adaptive Differential Pulse Code Modulation (ADPCM) is a form of pulse code modulation 
(PCM) that produces a digital signal with a lower bit rate than standard PCM. The Rio 800 
uses ADPCM for voice recording. ADPCM produces a lower bit rate by recording only the 
difference between samples and adjusting the coding scale dynamically to accommodate 
large and small differences. 

Bit Rate
Bit rate denotes the number of bits per second used to represent an audio signal. The size 
and quality of a digital audio file is determined by the bit rate used when encoding the file. 
The higher the bit rate used, the higher the sound quality and the larger the file size. For 
example, with MP3, a bit rate of 128 k is usually very close to CD quality, and takes up about 
1 MB per minute of music. At a 64 k bit rate, the sound quality is similar to that of an FM radio 
signal, but you may get around two minutes of music in that same 1 MB of storage space.

CDDB
See Gracenote.

Codec
Depending on the context and the kind of technology involved, codec may be defined in two 
ways. In telecommunications, a codec is usually a �coding/decoding� chip used to translate 
between digital and analogue transmissions. A modem uses one to interpret incoming 
analogue signals and converts the digital data stream coming from the computer into 
analogue. A codec is also defined as a compression/decompression algorithm. Codecs are 
used to compress audio data into a file, often for efficient transmission over a network, and 
then decode it for playback. 
The Rio 800 supports the following digital audio file codecs:
� MP3
� WMA
� ADPCM�for voice recording
� ACELP.net (Audible) 
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DRM, security
Digital Rights Management (DRM) technologies protect copyright ownership of digital 
information. DRM became an issue with the rise of MP3 technology and Internet distribution 
of music. DRM platforms serve as a security �wrapper� around digital audio supporting 
Internet distribution while at the same time protecting and managing rights related to that 
digital information. 
The security mechanism in the Rio supports several secure file formats. When you download 
a secure track from a CD or the Web to the Rio, you must have the licence associated with 
the track. If the Rio does not read a corresponding licence for a track, the tracks themselves 
contain information on where you can purchase them. Publishers can program restrictions on 
how many times you can play, copy, or distribute a song directly into the music files. Although 
the Rio includes security, it is still able to accept and play standard MP3 files. 

Encoding, or Ripping (a CD)
Encoding, or �ripping�, refers to converting an audio file from an audio CD into a compressed 
digital audio format, such as MP3 or WMA, that may be played on the Rio or a computer.

Firmware
Firmware is software�programmes or data�that has been written to read-only memory 
(ROM). Firmware is a combination of software and hardware that is comparable to an 
operating system on a computer. The Rio firmware controls everything from the liquid crystal 
display and codec support to the Rio�s many other functions. 
To view your Rio�s firmware version:
1 Press the Menu button.
2 Press the << or >> (Forward or Reverse) joypad buttons to navigate to About.
3 Press Select (Centre joypad button). The firmware version the Rio is using is displayed.
How to upgrade the Rio firmware

Gracenote
Gracenote, formerly known as the CD Database (CDDB), is a vast database of CD 
information that includes artist, disc name, song title, and other information. Gracenote 
supports hundreds of third-party software CD players. Software programmes use CD serial 
numbers to search the Gracenote Web site for CD information. Access to the Gracenote 
service is offered free of charge to end-users. Visit the Gracenote Web site for 
more information.

http://www.cddb.com
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MP3
MPEG-1, Layer 3 Audio (MP3) is a compressed digital audio file format. This format allows 
for near CD-quality sound, but at a fraction of the size of normal audio files. MP3 conversion 
of an audio track from CD-ROM reduces the file size by approximately a 12:1 ratio with 
virtually no loss in quality. This digital sound encoding and compression process was 
developed by the Fraunhofer Institut für Integrierte Schaltungen and Thomson Multimedia. 
MP3 uses perceptual audio coding and psychoacoustic compression to remove the 
redundant and irrelevant parts of a sound signal that the human ear does not hear. It also 
adds a Modified Discrete Cosine Transform (MDCT) that implements a filter bank, increasing 
the frequency resolution to 18 times higher than that of layer 2. The MP3 encoding process is 
well suited for the transfer of high quality audio files with small file size over the Internet. 

Playlist
Playlists let you organise lists of tracks to play in the order you choose. Playlists make it 
easier to manage large collections of music.

Ripping
See Encoding.

SDMI
The Secure Digital Music Initiative (SDMI) is a forum of over 130 companies in the fields of 
recorded audio content, computers, and consumer electronics, for the purpose of developing 
an integrated method of copyright protection technology that can be used worldwide. SDMI is 
working to create a framework for preventing improper usage of audio files and to promote 
legal music distribution services.

Skin
The skin is the software option that determines how digital audio player software applications 
appear on your computer screen. Some applications allow you to customise the colour and 
window design of your software by changing the skin. Some skins omit certain playback 
controls for simplicity.

USB
Universal Serial Bus (USB) is the external bus standard that supports data transfer rates of 
12 Mbps (12 million bits per second). The Rio uses USB to communicate with the computer. 
A single USB port may be used to connect up to 127 peripheral devices, such as mice, 
modems, and keyboards. USB also supports Plug-and-Play installation and hot plugging. It is 
expected to completely replace serial and parallel ports.

WMA
Windows Media Audio (WMA) is the compressed audio format created by Microsoft as a 
alternative to MP3. WMA may replace MP3 since it offers greater file compression�twice 
that of MP3�at the same or better sound quality.
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How do I put music on the Rio?
The Rio interfaces with your computer through the USB port. Use the software included to 
download digital audio tracks from your computer to the Rio. You can get digital audio from 
numerous Internet sites or encode your own digital audio tracks from your audio CDs using 
the CD-ROM drive on your computer. 

Can I use the Rio with Windows 95? I have the USB supplement pack.
No. The Rio USB devices can only be used with Windows 98, Windows ME or Windows 2000 
operating systems, or Mac OS 8.6 or later. The Rio requires a newer standard of USB that is 
not available in Windows 95, even with the USB supplement pack.

Where is the serial number located on the Rio?
The serial number is on the back of the Rio under the backpack. Remove the backpack from 
the Rio to see the serial number (S/N).

How do I upgrade the Rio firmware?
Checking your Rio�s firmware version

Important: First determine the version of the firmware installed on your Rio. Do not 
�downgrade� your Rio firmware by installing an older version. 

1 Press the Menu button.
2 Press the << or >> (Forward or Reverse) joypad buttons to navigate to About.
3 Press Select (Centre joypad button). The firmware version the Rio is using is displayed.

Downloading the firmware upgrade from the Rio Web site
1 Go to the Rio Web site
2 Click on Support, then click on Firmware upgrades.
3 Select and download the latest Rio 800 xxxx.exe (PC) or Rio 800 Update xxxx (Mac) 

firmware upgrade file to your computer.

Upgrading the Rio firmware (PC)
Important: Do not close the program, turn off the Rio or unplug the USB cable during 
the upgrade.

1 Connect the Rio to the computer using the USB cable.
2 Slide the Rio power switch to On.
3 Double-click on the Rio 800 xxxx.exe firmware upgrade file. The RioFlasher window 

is displayed.
4 Click on the Upgrade Now button on the RioFlasher window. 
5 Click on Yes.
6 When the upgrade is complete, a check of the firmware version displays the new 

version number.

http://www.riohome.com
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Upgrading the Rio firmware (Mac)
Important: Do not close the programme, turn off the Rio or unplug the USB cable during 
the upgrade.

1 Connect the Rio to the computer using the USB cable.
2 Slide the Rio power switch to On.
3 Double-click on the SoundJam icon. The Rio Connector window is displayed.
4 Click on the Settings... button on the Rio Connector window. The Rio Settings window 

is displayed.
5 Click on the Upgrade Firmware button on the Rio Settings window.
6 Choose the Rio 800 Update xxxx firmware upgrade file.
7 Click on the Open button.
8 When the upgrade is complete, a check of the firmware version displays the new 

version number.

The Rio is connected to the USB, why doesn�t the computer recognise it?
First, make sure the Rio software is running and check to make sure the USB cable is fully 
connected to both the Rio and the computer. Then turn the Rio off and back on. 
If this does not fix the problem, from within the Rio Audio Manager software click on the View 
menu, click on Options, then click on the Portable tab. In the drop-down list, change 
Autodetect device to Rio800.

Is the Random menu function truly random?
No. The Random function uses an algorithm called pseudo-random which is common to all 
computers. The Rio selects a seed number and then enters a list of predetermined random 
numbers to play music in a seemingly random order. If the same seed is picked, the Rio may 
play songs in the same order.

Can I play animated graphics on my Rio at startup?
Startup animated graphics may be available at www.rioport.com or other Web sites in the 
future. Instructions for their use and how to load them on the Rio will be available on the 
Web site.

I registered the Rio Audio Manager software on my first computer, but 
when I install it on another computer, it tells me that the code is not valid. 
The licence is system specific. If you plan to use the software on multiple computers, you 
must register the software on each computer.

How do I unlock Rio Audio Manager so I can encode more CDs?
Rio Audio Manager allows 50 free MP3 encodes prior to a free upgrade that unlocks Rio 
Audio Manager for unlimited MP3 encoding. WMA is the default setting for encoding CDs and 
there is no limit to how many WMA encodes you can make.
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Note: The Rio must be connected to the computer and turned on to complete the 
online upgrade.

1 Double-click on the Rio Audio Manager Icon to run the program.
2 Click on the Help menu at the top of the screen.
3 Click on Upgrade Online. 
4 Follow the instructions on the screen.
5 You will receive your unlock code/certificate number by e-mail.

How do I register my SoundJam software online?
SoundJam allows 50 encodes prior to registration. 
1 Double-click on the hard drive icon.
2 Double-click on the SoundJam folder.
3 Double-click on the SoundJam MP icon to open the program. You will immediately be 

prompted to register online. 
4 Click on the Register Now button.
5 Follow the instructions on the screen.
6 You will receive your unlock code by e-mail.

Why do I get an error when I click on Read a CD to start encoding?
The following factors may interfere with the CD encoding process:
1 Over-utilisation of the CPU during the encoding process. Close all other software 

before encoding.
2 Insufficient RAM to cache the track properly. Generally, 64 MB is fine if no other memory-

intensive application is running. Close all other software before encoding. Win 98 uses 
about 15-20 MB of RAM at startup depending on what applications you have running.

3 CD-ROM firmware. Even if a CD-ROM drive is new, it may require a firmware update from 
the manufacturer to correct audio extraction errors.

4 Overclocking. Overclocking the system�running it faster than it is rated to run�can have 
adverse effects on the peripheral components. If your system is overclocked, bring it back 
to its normal operating speed.

5 Try manually changing the settings that Rio Audio Manager assigns to your CD drive. To 
do this, go to View>Options>Read CD. If it is set to Digital (WinAspi), try changing it to 
Digital or vice-versa. If you have a sound card, change it to Analogue. Analogue may 
be slow. 

How can I get the best sound quality when encoding from a CD?
If you use a significant amount of your computer system�s resources with other applications, 
encoding songs from a CD may result in poor quality recordings. If the song(s) you encode 
contain abnormalities such as pops or skips, close down other applications which are running 
and encode those songs again. The condition of the audio CD�scratches and so on�may 
affect the quality of the recording as well.
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Our warranty to you
SONICblue, Incorporated warrants that your product will be free from defects in materials and 
workmanship for a period of one year from the date of original retail purchase. If you discover 
a defect covered by this warranty, we will repair or replace the product at our option using 
new or remanufactured components. SONICblue, Incorporated's liability is limited solely to 
the repair or replacement of the defective product. This warranty is extended to the original 
end-user purchaser only and is not assignable or transferable to any other party. Any parts or 
boards removed in the replacement or remanufacture process shall become the property of        
SONICblue, Incorporated. Out of warranty service may also be available for a fee.

How to obtain service under this warranty
To obtain service under this warranty, please contact the dealer from whom you 
purchased this product or call the SONICblue, Incorporated Customer Care Centre 
on +44-(0)870-870-5727 for return instructions. 
Customer Care hours of operation are:
� Monday to Friday 8.00 until 19.00 GMT
� Saturday 8.00 until 15.00 GMT
You must deliver the product and the original sales receipt to either the dealer from 
whom you purchased this product or to SONICblue, Incorporated in order to obtain service 
under this warranty. If you return the product to us, you must pay for postage to 
SONICblue, Incorporated.

Product failures not covered by this warranty
This warranty covers defects in manufacture that arise from correct use of the device. It does 
not cover damage caused by abuse, misuse, improper modification or repair, moisture, 
extreme heat or cold, corrosive environments, transportation, or high voltage surges from 
external sources such as power lines, telephone lines, or connected equipment. This 
warranty does not cover wear and tear on covers, housing or wiring. This warranty likewise 
does not apply to any product with an altered or defaced serial number.

How to obtain out of warranty service
To obtain out of warranty service, please contact the SONICblue, Incorporated Customer 
Care Centre on +44-(0)870-870-5727 (see above for hours of operation).
Out of warranty service is provided for owners of Rio 800 Personal Digital Music Players who: 
� Are unable to provide valid proof of purchase for their Rio Personal Digital Music Player.
� Require repair service after the expiry of the original warranty.
� Require service for product failures not covered under the SONICblue, Incorporated 

warranty on this product.
Out of warranty service is limited to the Personal Digital Music Player only and is not 
available for headphones, memory cards or other accessories.
The fee for out of warranty repairs is payable by credit card at the time the service agreement 
is created and Return Authorisation is provided. This fee includes all labour, parts needing 
replacement, and return postage. 
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You must deliver the product to SONICblue, Incorporated in order to obtain out of warranty 
service. You must pay for postage to SONICblue, Incorporated. It is recommended that you 
use a postal service providing you with tracking capability, because we will not be responsible 
for items lost in the post. A Return Authorisation number is required for all products sent to 
SONICblue, Incorporated. Please contact our Customer Care Centre for more information or 
to arrange for out of warranty service.

Limits of liability
We are responsible only for the repair of this product. We will not be liable to you or anyone 
else for any damages that result from the failure of this product or from the breach of any 
express or implied warranties. These include damage to other equipment, lost data, lost 
profits, or any consequential, incidental, or punitive damages. IN NO EVENT WILL 
SONICblue, Incorporated BE LIABLE FOR ANY AMOUNT GREATER THAN THE 
CURRENTLY SUGGESTED RETAIL PRICE OF THIS PRODUCT. 
THIS WRITTEN WARRANTY REPRESENTS THE ENTIRE WARRANTY AGREEMENT 
BETWEEN SONICblue, Incorporated AND YOU. THIS WARRANTY IS GIVEN IN LIEU OF 
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. THIS WARRANTY IS LIMITED TO THE TERM SPECIFIED ABOVE. NO 
WARRANTIES, EITHER EXPRESS OR IMPLIED, WILL APPLY AFTER THIS PERIOD. 
THIS WARRANTY MAY NOT BE ALTERED IN ANY WAY OTHER THAN IN WRITING BY 
AN OFFICER OF SONICblue, Incorporated. This warranty gives you specific legal rights and 
you may also have other rights, which vary. 
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EU Declaration of Conformity
We; 
DIAMOND Multimedia Systems Vertriebs GmbH
Moosstrasse 18b
D-82319 Starnberg
GERMANY
On behalf of; 
SONICblue, Incorporated
2841 Mission College Blvd.
Santa Clara, CA 95054 USA
Hereby declare under our sole responsibility that the following product(s) conform to the 
requirements of the European Parliament Council Directive 1999/5/EC dated 9th March 
1999. And to which this declaration is related the product(s) listed are in conformity with the 
following relevant harmonised European Standards or other normative documents, the 
references of which have been published in the Official Journal of the European 
Communities / European Union.
Product(s): RIO 800
Harmonised Standards: 
EN 55022: 1994, A1 �95, A2 �97 Specification for limits and methods of measurement of 
radio interference characteristics of Information Technology (ITE) Equipment.
EN 50082-1: 1998 Electromagnetic Compatibility, Generic Immunity Standard, Part 1. 
Residential, Commercial and Light Industry.
EN 50332-1: 2000 Maximum sound pressure level measurement methodology and limit 
considerations. Part 1 General method for �one package equipment�.
CEI/IEC 60065: 1998 Audio, Video, and Similar Electronic Apparatus Safety Requirements.
In accordance with the terms of Directives 1999/5/EC, 89/336/EEC, 73/23/EEC and Council 
Decision 98/482/EC, the original signed Declaration is retained by us in the product 
compliance folder. Upon request photocopies may be provided.
Date: 07 February 2001 
Place: St. Ingbert, Germany 
Name of Authorising Person
Scott Naccarato
Regulatory Compliance Manager
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Customer Care
Hours of Operation
Monday to Friday 8.00 until 19.00 GMT
Saturday 8.00 until 15.00 GMT

Telephone Support - all Products
+44-(0)870-870-5727
Fax Support- all Products
+31-53-484-9536

Web site
http://www.diamondmm.co.uk

Postal Address
SONICblue/Diamond
European Customer Care Center
P.O. Box 52
7500 AB Enschede
The Netherlands

http://www.diamondmm.co.uk
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